Getting Started
This document is a printable version of the Getting Started section of the
integrated online Help file. We recommend that you read and fully
understand this document before you begin to use the software.

Ability Accounts (Small Business) is the ideal software package to help the start-up or micro business manage
its finances and business processes. As your business grows and you demand more from your business
software, Accounts (Small Business) offers a seamless upgrade through the wider range of Ability software
products which offer many integrated front-office business processes and further valuable management
information.
Please contact your supplier or ASI Ability directly to explore the opportunities to enhance your business
software experience with Ability Accounts (Small Business).
Upgrade opportunities include:
•
Enhanced Nominal Ledger, Financial Core and Reports
•
Supply Chain Management - Quotes, Sales Order Processing, Purchase Order Processing
•
Comprehensive Stock Management
•
Job Costing and Contract Management
•
Multi-site, Remote access
•
Electronic Point of Sale
•
Report Generator
•
Customer Relationship Management
•
E-Commerce
•
Payroll
•
Bespoke modules, interfaces and reports
As your business grows, so can your chosen Ability business software solution.
www.asiability.com
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End-User Licence Agreement
This is a legal agreement between you as the licensee and Diamond Discovery Software Limited. Use of this Diamond Discovery Software
product (the “Software”) is conditional upon your acceptance of the terms and conditions of this agreement.
Grant of Licence
Diamond Discovery Software Limited grants you, the licensee, a licence to use the Software, subject to the terms and conditions of this
agreement. You may only use the Software on up to the specified number of computers. If you wish to use the Software on more than the
specified number of computers, you must license additional copies of the Software. This licence agreement is non-transferable.
Term
This licence commences on the date you accept the terms of this agreement. If any of the terms and conditions of this agreement are
broken, Diamond Discovery Software Limited reserves the right to terminate the licence immediately and demand that you discontinue
using the Software, return the Software to Diamond Discovery Software Limited and certify in writing that you have not retained any copies
of the Software.
Copyright and Other Restrictions
You acknowledge that the copyright and all other rights to the Software and manuals and other related materials are the sole and exclusive
property of Systems 80 Limited. By accepting this agreement, you do not become the owner of the Software, but you can use the Software
in accordance with the terms and conditions of this agreement. You may not transfer, sub-license, rent, lease, time-share or lend the
Software, manuals or any related materials. You may not copy the Software except to make one copy solely for backup or archival
purposes. You must retain any archival copy in your possession. You may not remove or obscure any copyright notices. You may not alter,
decompile, disassemble, reverse-engineer or in any other way obtain any source code from the Software. You agree to take all reasonable
steps and use your best efforts to protect the Software from unauthorised use and illegal copying or distribution.
Limitation of Liability
Should any unaltered version of the Software be found to contain any errors, Diamond Discovery Software Limited will take all reasonable
steps to correct the error on receipt of documented proof of any such error or malfunction. If any such error has been fixed in the latest
version of the Software, Diamond Discovery Software Limited reserves the right to supply an upgrade to the latest version by way of
correction of the error. This warranty is limited to 12 months from the commencement of this agreement and is subject to: (i) you complying
with your obligations under this agreement; (ii) the Software not being altered, modified or added to without the approval of Diamond
Discovery Software Limited; and (iii) you complying with any instructions included with the Software. Diamond Discovery Software Limited
does not warrant that the Software does not contain any errors and shall not be liable, in any way, for any consequential or indirect loss
resulting from the existence of such errors, or any loss or damage resulting from the use of the Software in any way or for any purpose
(except personal injury or death resulting from Diamond Discovery Software Limited’s negligence or breach of this agreement). Diamond
Discovery Software Limited will not be liable for any consequential or indirect loss or damage or loss of profits, business revenue, goodwill
and/or anticipated saving resulting from the use of the Software. In respect of any other claim, in no event shall Diamond Discovery
Software Limited’s liability exceed the amount paid by you for the Software.
Except for the warranty stated in this agreement, Diamond Discovery Software Limited provides the Software without any further warranty
of any kind, express or implied, including the implied warranties of fitness for a particular purpose. No third party shall have any rights
under or in connection with this agreement by virtue of the Contracts (Rights of Third Parties) Act 1999. This agreement is governed by
English law. Any terms or conditions of the agreement that are found to be unenforceable will be deleted, but will not affect the remaining
terms and conditions of the agreement.

-3-

Installing the System
System
Requirements

To run Accounts (Small Business) we recommend the following configuration
A Personal Computer with a 500MHz processor or 1.2GHz for Vista
•
•
512MB RAM or 1GB RAM for Vista
•
Up to 100MB disk space for installation. Additional space will be required for your data.
•
SVGA monitor with minimum 800x600 resolution
•
CD/DVD
•
Windows 2000/2003/XP/Vista
The system may work on lesser hardware and software configurations but performance cannot be guaranteed.

Installation

1.
2.
3.
4.

5.
6.

7.
8.

9.
10.
11.
12.
13.
14.

Ensure all other users are off the system.
Close all other programs.
Insert the installation CD into the CD or DVD drive.
If the CD does not autorun:
a) Left Click Start > Run and enter X:\SETUP into the dialog box, where X is the drive letter of your
CD or DVD drive;
b) Left Click OK.
The Setup Wizard will appear. Follow the instructions displayed. You can Left Click Cancel to close the
Wizard without installing the program.
Left Click Next to select the Directory into which the program will be installed (the Target or Root
Directory). Either:
a) Left Click Next to install the program into the default directory shown - recommended for
first-time users, or;
b) browse and select the Target Directory and then Left Click Next to install into this directory and
open the next screen.
Confirm the Installation Type from the drop-down box:
a) 'Single (Standalone) P.C. or Server' for the first time and upgrades;
b) 'Workstation' for non-server installation on a network - see Select Directory Form
Left Click Next to continue the installation and open the next screen to select which Start Menu folder will
contain program shortcuts. Either:
a) Left Click Next to use the default folder shown - recommended for first-time users, or;
b) browse and select a folder and then Left Click Next to open the next screen.
Select required Icon display options from those displayed and Left Click Next to open the next screen.
This will display a summary of all the options that you have selected, so giving you an opportunity to
change any selections you have made up to this time. If you want to change any selection, Left Click Back
to navigate to the screen you require. Make any changes, and Left Click Next to move through the screens.
Once you are satisfied with your selections, Left Click Install to being installation.
The system will then install itself and will display progress on the screen.
Once installation is complete, the Wizard will confirm this on screen. Left Click Finish to close the Wizard.
Start using the System - see Opening the Program
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Technical Notes
Directory Structure
and Files

The installation folder specified (usually C:\Program Files\'Root Directory') contains the main program,
supplemental applications and some support files (RESOURCE.DAT, etc.). Sub-directories are then created for
each company using the naming convention DATA.0XX, where XX is the company number. Company 00 is
considered the main company and cannot be deleted. Within each company sub-directory are the databases
and indexes which make up the company’s accounts.
The system requires these files to be in specific locations relative to the Root Directory and does not expect any
other files to be there. The Root Directory itself, however, can usually be used to store files but with one
important condition: you MUST NOT put a database or an index in the Root Directory that has the same name
as one of the company databases.
The situation is different for the sub-directories. DO NOT put any other files in these sub-directories and DO
NOT create directories within them. If either of these rules is not followed you will at least lose these "alien" files
and automatic updates will not work properly.

System Capacities & Please allow at least 100 MB of disk space for an initial installation.
File Sizes
The maximum regarding the number of accounts and transactions that the system can reach currently exceeds
other practical limitations e.g. hardware.
Backing Up Your
Data

It is essential, as with any computer system, that you make regular backups of your data. This means that you
copy the data holding your system information as a precaution against the data on your hard disk becoming
corrupted or lost, or your hard disk or computer becoming damaged - not such an unlikely event as you may
think. Also remember that back-up media themselves can become corrupt or get lost so the more backups you
have, the safer you are.
The actual procedure for taking backups depends on your particular hardware configuration and operating
system. Your supplier should be able to install a simple to use back-up procedure for your system.
Remember to store a copy of a backup in a safe place, preferably away from your workplace.
For more on backing up your data see Back Up & Restore Company Data.
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A Rough Guide to Double-Entry Bookkeeping
Background

Accounts (Small Business) is an integrated accounts program which operates in real time. The system
incorporates sophisticated controls which ensure that each transaction is processed correctly and completely, to
ensure the system remains in balance and as up to date with the most recently posted transactions.
That being said, there will be occasions when you will need to make adjustments to posted transactions. The
text in this section has been included as a reference to the main principles behind the design of the system. We
recommend that you read this before using the system for the first time.

Double Entry
System

Accounts (Small Business) uses the Double Entry (or Double Entry Bookkeeping) System, a standard
system used by businesses and other organisations to record financial transactions. First codified in a 15th
Century Mathematics Textbook, its premise is that a business's (or other organisation's) financial condition and
results of operations are best represented by several variables, called Accounts, each of which reflects a
particular aspect of the business as a monetary value.
Every transaction is recorded by entries in at least two Accounts. The total of the Debit values must equal the
total value of the Credit values. The premise for this is that any monetary transaction must logically affect two
aspects of a company.
The Double Entry system forms the basis of the Bookkeeping and Accounting Process which operates within
Accounts (Small Business).

Bookkeeping and
Accounting Process

1.

2.

3.
4.

5.

6.

7.

In the normal course of business, a Source Document is produced each time a transaction occurs. As an
example, when goods are despatched, Sales Invoices are produced and sent to Customers. The
Bookkeeping Process starts with Source Documents being recorded into a Book of Prime Entry or
Daybook - see Produce Sales Invoices for an example of how a Daybook works in Accounts (Small
Business).
Daybook entries are then transferred to accounts in a Ledger - a Task called Posting. As an example, a
Sales Invoice for goods despatched to a Customer will be recorded in that Customer's Account in the Sales
Ledger, and also in the VAT and Revenue Account(s) in the Nominal Ledger - see Post Sales Invoices to
the Ledger.
Once all Transactions have been Posted, the entries in each Ledger Account are added up to give a total
value which is the Balance on that Account.
A Trial Balance can now be printed which lists all the Balances at the date of the Trial Balance (e.g. month
end date) from all the Ledger Accounts in the Nominal Ledger. The amounts are copied to a two column list
with Debit balance amounts recorded in the left column and Credit balance amounts recorded in the right
column - see Print or Display a Trial Balance to display a Trial Balance.
The Accounting Process begins with a review of the Trial Balance to ensure that Account Balances
comply with accounting principles. Any necessary adjustments to Balances can be made using Journal
Entries - see Make Nominal Ledger Adjustments. This process continues until the resulting figures are
correct.
Financial Statements can be prepared from the Trial Balance, which may include one or more of the
following (not an exhaustive list):
a) A Profit and Loss Account, or simply P&L,
b) A Balance Sheet,
c) A Cash Flow Statement - if required,
d) Management Information as required.
The Financial Statements are then available for use by one or more of the following (not an exhaustive list):
a) Management,
b) Banks, and other Lenders,
c) Suppliers - for assessing Credit Terms.

The diagram below shows how Daybooks and Ledgers are linked in Accounts (Small Business).
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Design Structure

Debits and Credits

The Double Entry system is governed by the Accounting Equation; this states that at any point in time, the
following must hold true:
Assets + Expenses = Liabilities + Revenue
Put more simply, at any time, within the System's Data Tables:
Total Debits=Total Credits and the system is in Balance
For Ledger Accounts to remain in Balance, a change in one account must be matched with a change in another
account. These changes are known as Debits and Credits and therefore each business transaction will
comprise both a Debit and a matching Credit.
Remember that Debits and Credits are neither positive nor negative values. Positive and negative values allow
for mathematical calculations in software programs. The Balance on a Ledger Account is either a Debit or a
Credit (not a positive or a negative value) and is the net total of all the Debit and Credit transactions Posted to
that Account at the time it is Balanced. Accounts (Small Business) recognises this when updating and reporting
data.
On a Ledger Account, Debits are recorded on the left side and Credits on the right side for each account - see
Customer Account Enquiry for an example of a Ledger Account.

Debit Balances...

...are normally found on (not an exhaustive list):
Asset Accounts - For example, the cost of Computer Equipment;
•
•
Trade Debtor Accounts - For example, a Sales Invoice posted to a Sales Ledger Account;
•
Cash Accounts;
•
Other amounts due from third parties but not yet received. One example might be an advance on an
employee's salary;
•
Expense Accounts - examples are Fuel Costs, Stationery Costs or Rent Payable.

Credit Balances...

...are normally found on (not an exhaustive list):
Liability Accounts - For example Bank Loans;
•
•
Bank Overdrafts and other amounts owed to third parties but not yet paid such as the costs of Goods
received but not Invoiced by a Supplier;
•
Trade Creditor Accounts - For example, a Purchase Invoice posted to a Purchase Ledger Account;
•
VAT and PAYE Accounts;
•
Revenue Accounts.
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Invoices and Credit
Notes

Throughout the Help file you will see references to Invoices and Credit Notes. It is useful to define these so that
you can put such information into context.
An Invoice is a commercial document in a form consistent with the trade identifying both buyer and seller,
reflecting the price actually paid or payable, the terms of sale, the currency used for payment, the articles sold,
and other specific information required for duty assessment purposes.
A Credit Note is a monetary instrument issued by a seller that allows a buyer to purchase an item or service
from that seller on a future date. Credit notes may be issued by a seller as a goodwill gesture to a buyer who
wishes to return previously purchased merchandise (instead of cash repayment) in circumstances where the
original sales agreement did not include an explicit refund policy for returned items. In such circumstances, a
credit note of value equal to the price of the returned item is usually issued allowing the buyer to exchange his
purchase for other items available with the sale.
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Opening the Program
Starting Up

1.

2.
3.
4.
5.
6.

7.
8.
9.

Either:
a) Double Left Click on the Accounts (Small Business) Icon on your Desktop, or;
b) Left Click Start > All Programs > Accounts (Small Business), or;
c) Left Click on the Accounts (Small Business)Icon on the Start Menu.
While the software is loading you will see a form displaying copyright and user information.
When you start Accounts (Small Business) for the first time you will see the Getting Started - Prompt. This
invites you to open the Getting Started Wizard to set up a new Company for your business.
Then you are requested to choose a Company by selecting from a list displayed on a Form - see Change
Companies.
Company Password - if the Company has been assigned a password you will be asked to enter it here see Parameters Form.
The program comes with 2 Companies already created:
a) Company 00 - the main company from which all others can be created - see Create New
Companies;
b) Company 99 - contains dummy data which once copied, can be used to experiment or for
training other users.
Note that as you create more companies you will be able to select any one of these when you open the
program.
Enter Accounting Date - this is the Default Transaction date used for all parts of the system and is
completely independent of the computer’s system date. It will appear by default whenever you are required
to enter a date, for example when creating an invoice - see Change Default Transaction Date.
Left Click OK to open the Workspace.

Menus

The Toolbar on the top left hand side of Workspace contains both the Main Menu...

Buttons

...and the Control Buttons
see Control Buttons for a detailed description of each.
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First-Time Use
Customers and
Suppliers

Enter the names and addresses etc. of your Customers into the Sales Ledger and the names and addresses etc.
of your Suppliers into the Purchase Ledger - see Create & Edit Customer Accounts and Create and Edit Supplier
Accounts.
If you have a large amount of Customer & Supplier data you may wish to Import it rather than Enter it - see Import
Customer Data, Import Supplier Data.

Products & Services Enter the descriptions & details of any Products, Services or Descriptions you may wish to use - see Add & Edit
Products or Services.
If you have a large amount of Products & Services data you may wish to Import it rather than Enter it - see Import
Products or Services Data.
Nominal Ledger

Decide if you need to change any of the Nominal Ledger accounts see Add & Edit Nominal Accounts.

Cashbook

Set up additional bank accounts - see Create Multiple Bank Accounts. Remember that you will need to create a
Nominal Ledger account for any additional bank account before adding this to the additional bank account list.

Stationery Design

Decide on a format for your stationery and discuss these with your ABC distributor. They will be able to help you
create Documents which can subsequently be printed on plain paper rather than more expensive pre-printed
stationery. See Stationery Design - Overview for details of how to do this.

System
Configuration

Set up the general parameters and the security that you require:
When using the System for the first time
•
•
When creating a new Company - see Create New Companies
•
When your business needs change – you may need to process data in a different way than before
•
When expanding and/or reorganizing your business
•
When you need to restrict user access to Companies - create a password to be input each time the
Company is selected
•
See Set or Amend the System Configuration for details.

Preparation

•
•
•

Filing

Print the details entered and keep this in a secure place, noting the date on the printout. If you subsequently
need to make changes to the details reprint and date the output. You may consider changing Company
passwords - keep a note of what these are and the date on which they changed in a secure place.

Ensure all other users are off the System.
Select the Source Company - See Change Companies.
If editing an existing Company ensure you have an up-to-date backup of the Company data both before
and after making any changes - see Back Up & Restore Company Data.
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Transferring Data into the System
Essential Reading

Before you move any data from your existing system(s) into Accounts (Small Business), we recommend that
you read all the Help topics shown in the Getting Started section of the Help file. This will give you an overview
of Accounts (Small Business).

Testing & Training

Accounts (Small Business) can contain up to 100 different Companies, numbered 00-99. Your system comes
with two already created, 00 and 99. 99 is a demonstration company and the data can be copied to a newly
created company to provide a safe workspace where you can familiarise yourself with the system. See Create
New Companies. Number the new company '98' and label this Company 'Test & Training'.

Planning

Transferring balances from another system onto a company for the first time should be carefully planned to
minimise disruption to your business. Some points you may wish to consider are listed below.

Preparation - Timing

Decide when you want to move data across. It is much better to do this after running Period or Year End.

Preparation - Sales & •
Purchase Ledgers
•
•
•

•
•

Preparation Products & Services

•
•
•
•
•

Preparation Nominal Ledger

•
•

•
•
•
•
•

Standing Data - is this up to date? - Consider sending a circular to customers and/or suppliers asking them
to confirm their names addresses and contact details.
Do I need to transfer all accounts now? - Transfer only those accounts with live balances. Keep a record of
all other accounts so that these can be created easily.
Transactional Data - is this clean? Review the ledgers for slow moving and credit and debit balances. Try
to resolve as many outstanding issues as possible and adjust the ledgers accordingly.
Design an Account Code format and structure - Accounts (Small Business) allows 8 Alphanumeric
characters for each Account Code, the more characters you use, the greater number of accounts can be
create. The program will display these firstly in Alphabetic Order and then in Number Order within each
letter. As an example - Discovery Wines demonstration company uses a three character alphanumeric
account code for both Sales and Purchase ledger accounts. A customer whose name begins with 'A' could
have, for example, the Code A07. Using this combination of letters and numbers can create up to 2600 (26
letters x 100 number each) accounts in total, with 100 for each letter of the alphabet.
Decide on a standard format for Standing Data (are you going to use upper, lower or proper case entries?).
Create the new Accounts in Accounts (Small Business) - see Create & Edit Customer Accounts, Create &
Edit Supplier Accounts, Import Customer Data, Import Supplier Data.
Review product codes and descriptions for consistency and duplication and amend data.
Decide on Product Code format and structure - Accounts (Small Business) allows 16 alphanumeric
characters for each Product Code. List out the Product Codes you will need.
Decide on the format to be used for Product and Service descriptions.
Decide whether slow moving or obsolete items need to be transferred.
Create Product & Service Codes in Accounts (Small Business) - see Add & Edit Products or Services,
Import Products or Services Data.
Transactional Data - is this clean? Review the ledgers for unusual items. Try to resolve as many
outstanding issues as possible and adjust the ledgers accordingly.
Decide how many Nominal Ledger Accounts you will need and map the existing Nominal codes to the new
structure. You will then be able to see how many new accounts you need to create. Accounts (Small
Business) uses a two-tier 4 character code. See Add & Edit Nominal Accounts for a description of this.
Decide on a standard format for Standing Data (are you going to use upper, lower or proper case entries?).
Ensure all control and bank accounts are fully reconciled and resolve any outstanding issues.
Run a Trial Balance as at the Transfer Date - account balances will form the basis of opening journals.
Create any additional Nominal Accounts - see Add & Edit Nominal Accounts.
Create Bank Accounts - see Create Multiple Bank Accounts.

Transferring Data

Once you have completed the preparation and you are satisfied that the data you will be transferring onto
Accounts (Small Business) is completely up to date and correct, you can begin transferring data to the system.
We recommend that this be done in the following order:
1. Enter Company Standing Data - see Set or Amend the System Configuration.
2. Enter Sales and Purchase Ledger Standing Data - see Create & Edit Customer Accounts, Create & Edit
Supplier Accounts - to save time, you could do this before you use each Customer or Supplier Account for
the first time. If you do this, it's a good idea to keep a note of which accounts have not yet been transferred.
3. Enter the Opening Balances into the Ledger Accounts.

Enter Opening
Balances

We recommend that First Time Users read A Rough Guide to Double-Entry Bookkeeping before posting
Balances created on another system onto Accounts (Small Business). This will give you a good overview of
system design and structure and help put this task into context.
1.
2.
3.
4.

Select a Company - see Change Companies, Create New Companies.
Set up the Company - see First Time Use.
Left Click Menus > Ledgers > Nominal > Journals to open the Nominal Ledger Journal Entry Form.
Input Purchase Ledger balances as follows - Credit Ledger Accounts, Debit Suspense Nominal Accounts.
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5.
6.

Post Sales Ledger balances as follows - Debit Ledger Accounts, Credit Suspense Account
OK to post the journal - this will create a debit entry in the Sales Ledger Control account on the balance
sheet.

The graphic below illustrates posting Sales and Purchase Ledger balances transferred onto Accounts (Small
Business). As transactions are posted to Ledger Accounts, the program will automatically post a Debit or Credit
entry for the same amount into the Nominal Ledger Control Accounts. Unless the above procedure is followed,
the Control account entries will be duplicated and the total of all individual Ledger Account Balances will not
equal the Balances on the relevant Control Accounts.

7.
8.

Post the remaining Balance sheet accounts to the relevant Nominal Code apart from the Sales and
Purchase Ledger Control Account Balances.
Post the Ledger Control Account balances to the suspense account - the will be equal and opposite to the
entries you posted when transferring the individual ledger account balances.
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Using the System
Getting Help

The system contains a Context Sensitive Help function which is designed to show you how to get the most out
of your system. Simply press the F1 key when a Form is open to display the Help file section that relates to that
Form. Alternatively, Left Click Help on the Main Menu to open the Help File and then Left Click on the required
Topic.
Note also that blue-underlined text in the Help file navigates the reader between areas with commonality and
drills down into more detail. Left Click on a blue-underlined word or phrase to follow the link.

The Trading Cycle

All businesses create income through sales, profits through matching income and costs and realise those profits
in the form of cash. This ongoing process whereby a sale is made, incurs costs and generates profits and cash
is known as the Trading Cycle of a business.

The Sales Cycle

Typically, Customers who require your goods and/or services might contact you for a quote. If this quote is
acceptable, they will place an order. You will match this to your Inventory records and advise the Customer of the
delivery date. The details on the order will be passed to Despatch, and will be picked, packed and despatched in
accordance with your customer's instructions. Once goods are despatched/services are supplied, you will
generate a Sales Invoice, send this to the Customer, and subsequently collect the money. This on-going process
is known as the Sales Cycle.
Premium Editions of Accounts (Small Business) include an integrated Sales Order Processing module.
Once activated, the Sales Order Processing module processes Sales Transactions from quote through to cash
collection. You can configure the module to match existing processes, and track orders through a
comprehensive suite of reports.

The Purchase Cycle

In order to generate Income, each business needs to obtain goods and/or services from third parties outside the
business. The Suppliers will invoice your business for these and will expect payment in return. This process can
be called the Purchase Cycle.
Premium Editions of Accounts (Small Business) include an integrated Purchase Order Processing module.
Once activated, the Purchase Order Processing module processes Purchase Cycle transactions from Order
through to Payment. This connects automatically with the Stock Control and Sales Order Processing
modules to provide an extremely powerful tool to help manage Working Capital.

Working Capital

Working Capital measures how much cash and cash equivalent a company has available to build its business.
This consists of Stock + Debtors + Cash - Creditors. In addition to facilitating the management of Stock, Debtors
and Creditors, the system recognises that a business can pay amounts directly out of cash and make
adjustments for items that are neither cash nor invoiced amounts, such as payroll costs, credit card payments,
petty cash payments and so on. You may also receive bank interest, cash refunds etc. which have not been
invoiced. You may even receive your sales in the form of cash. Accounts (Small Business) helps manage this
through an integrated Cash Book - see Cashbook - How Do I?... for more information.
Modules combine to form a powerful Business Management Tool producing comprehensive Management
Reports using real-time data. For example, Left Click the Camera Button on the Toolbar just below the Main
Menu to see the up-to-date Debtor, Creditor and Cash balances - a snapshot of Working Capital that is up to the
minute and includes the latest transaction - see Review Bank, Debtors, Creditors and VAT Commitments.

Nominal Ledger

Accounts (Small Business) uses a (maximum) 8 digit two -part Account Code to create the Chart of Accounts.
This flexibility means that it is possible to recognise a company's management and reporting structure within the
Nominal Ledger, as well as comply fully with GAAP, HMRC and Statutory Reporting and Accountability
requirements.
Nominal, Sales and Purchase Ledger adjustments are all Transacted using a single form. All three can be
adjusted at the same time.

System
Configuration

Accounts (Small Business) includes a series of Utilities to allow you to create new Companies and reorganise
your data or even redesign an existing Company to reflect changes in your business, as well as design your own
stationery for printing on plain paper - see Stationery Design & System Control & Configuration - How Do I?... for
more information.

Supporting Your
Business

In order to efficiently maintain the Trading Cycle of your business, you will have designed your own methods and
practices which are tailored to meet customer expectations and maximise returns in the form of profits and cash.
The system is designed to support business method and practice by providing a comprehensive one-stop shop
to help record and manage:
•
Multiple Companies - up to 100 companies can be operated concurrently;
•
Sales - Measure Customer turnover and profit, control customer credit and maintain a log of customer
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•
•
Control Framework

contacts;
Purchases - Measure Supplier turnover and monitor Supplier accounts to help you get value for money;
Cash - Manage more than one bank account, record cash sales and payments.

Any system, be it manual, semi-manual (e.g.: using spreadsheets), or a computer program can only reproduce
accurate and complete data if the data input is accurate and complete. This is achieved using a Control
Framework to ensure that all the data required to be input to the system is available when required, and is
completely and accurately input. Put simply, what comes out of the system will only be as accurate as the input
- see also Suggested Month End Procedures.
The Control Framework consists of a series of ordered Processes. Each process is specific to a part of the
Trading Cycle.
Controls also exist within the program to ensure that data is processed correctly and completely and that once
updated, records can only be amended by using processes designed for this purpose - see Editing Data Entry.
The most important of these controls is the use of Transaction Periods. The ledgers operate in 12 monthly
periods, period 1 representing the first month of your financial year and period 12 the last. You control when the
transaction period changes by closing the Sales, Purchase and Nominal Ledgers individually each month using
a standard process - see Period End Processing. Once a Transaction Period is closed, no further changes can
be made to Transactional Data updated in that Period and hence the integrity of that data is maintained, and the
Ledger is considered to be Closed for the Transaction Period.
To operate this control we recommend that you process Period Ends for the Ledgers at the same time each
month. One way of doing this is to agree and publish a month end timetable with Managers in your Company at
the beginning of each Financial Year. This will then let everyone know when the Financial Periods will end in that
year, and will help you organise your time each month.

The Period Rule

Running Period End Processing in each of the ledgers moves that ledger onto the next Transaction Period.
Different ledgers can therefore be in different periods. When you run End of Period on any ledger it closes that
period and no further entries can be made to it. As the system is real-time - making entries in the Sales or
Purchase Ledgers always affects the Nominal Ledger for the same period - there must be control over which
periods each ledger can be in at any time.
This is governed by the Period Rule: this states that no ledger can be more than one period removed from any
other ledger and the Nominal Ledger cannot go ahead of either the Sales or the Purchase Ledgers. The system
automatically controls this and should you try to run End of Period when not permitted you will be prevented from
doing so and a message will be displayed to that effect.

Processes

Accounts (Small Business) uses clearly defined and instinctive Processes to update data and report
information.
Sales - generate Sales Invoices that are sent out to your Customers, who then pay you. Sometimes, you need to
change the value and/or amount of a good or service supplied and to do this you will need to issue a Credit Note.
As part of the Sales process you will need to maintain records of the Products and Services that you sell in order
to control profits.
Purchases - In order to generate Income, each business needs to obtain goods and/or services from third parties
outside the business. The suppliers will invoice your business for these and will expect payment in return.
Cash - You could also pay amounts directly from your cashbook and make adjustments for items that are neither
cash nor invoiced amounts, such as payroll costs, credit card payments, petty cash payments and so on. You
may also receive bank interest, cash refunds etc. which have not been invoiced. You may even receive your
sales in the form of cash.
System Control and Configuration - a series of utilities to allow you to create new Companies and reorganise
your data or even redesign an existing Company to reflect changes in your business, as well as design your own
stationery for printing on plain paper.
Nominal - using a single Journal to make changes to any combination of Sales, Purchase and Nominal Ledger
Accounts.
Processes are broken down into an ordered sequence of Tasks. These are designed to ensure that data entry to
the system is complete and correct and that the right people see the output. Whilst you don't have to use our
suggested tasks, they represented a tried, tested and efficient method of getting the best from your system.

Tasks

Each Process comprises one or more of the following Tasks, which are shown in the order in which they should
be completed. The Tasks are described in the Help file under headings corresponding to the six steps below.
You will see that not all processes require all 6 tasks.
The Tasks are:
1.
2.
3.

When and How Often – ...do you do perform this Task?
Preparation - Collect together the source data (e.g. Cheque books, Invoices, letters etc) that you
need. Sort paperwork into a logical order.
Processing:
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a.
b.
c.
d.

4.
5.
6.

Left Click the Menu to find the correct Form - see Tables, Records, Forms and Fields
Find the Record that you want to update and/or Report - see Finding Records
Open Pages as required and populate required Input Fields
Either Click 'OK' to accept the Data input and Update Records
or Open the Edit menu to correct or amend your input
e. Repeat c as required
Balancing/Reconciliation - How can I confirm that all the data has been processed accurately?
Consider annotating source data to system generated references.
Reporting - Does the data look right? Who needs to see this?
Filing - Is there a clear trail to the source data? How should this be filed for easy access by other
users?
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Tables, Records, Forms and Fields
Tables and Data

The system contains data that is grouped together in Tables. Each Table can contain either:
•
•

Standing Data - Customer, Supplier or Nominal ledger account details that generally are updated
infrequently. Examples of this are: Customer names and addresses and Nominal Account descriptions, or;
Transactional data - As its names suggests, this could be payments, receipts, accounting adjustments,
invoices, credit notes etc; in fact any item that produces an entry representing an event in Accounts (Small
Business) or generates a report. Each transaction will vary in timing and amount.

You may find it useful to think of a Table as an array of rows and columns - similar to a spreadsheet. Columns
contain data with similar values; rows contain data that is related in some way. Each entry in a column is called
a Field, and the collection of related Fields in a row is called a Record. Each Record is identified by a unique
reference Field, known as a Code.
What is a Form?

You instruct the program to perform an operation by using a Menu - see Menus. The system will then request
you as a user to supply the data it needs to complete your request. It does this by opening a Form.
A Form is a graphical interface between the user and the system. Forms contain Fields from one or more Tables
into which you will enter specific data in order to give the system the information it requires to carry out your
instructions. The Forms that you will use have been designed to make data processing easy, intuitive and
efficient - See Entering Data.

Sizing and Moving
Forms

Once a Form has been opened, you can change its size and/or its position on the Workspace. This will enable
you to customize the Workspace to suit your requirements by having more than one Form open at a time. You
can then easily switch between common recurring tasks.
To move Forms within the workspace - Left Click in the top section (Header) of the Form then, holding down the
Left mouse button, drag the Form to a required location in the workspace.
To resize Forms you use the buttons on the top right of the Form Header, as follows:
Minimize Button - Left Click to minimise the Form and move it to the bottom left corner of the Workspace.
The button changes to the Restore button - Left Click to restore the Form to its normal size in the same position
in the Workspace as when it was minimised.
Left Clicking anywhere on a minimised Form displays a menu with the following options:
1.
2.
3.
4.

Restore - Left Click to restore the Form to its normal size in the same position in the Workspace as when it
was minimised.
Move - Left Click - a cross appears on the Form. Using the mouse, drag the Form to a new position in the
Workspace and left Click to drop it in the new position.
Maximize - as Maximize button.
Close - Close the Form.

Maximize Button - Left Click to enlarge the Form to fill the Workspace. The button changes to the Restore
button - Left Click to restore the Form to its normal size in the same position in the Workspace as when it was
maximised.
Types of Form

Forms can either be Single Page or Multi-page depending on how these are displayed. A Multi-page Form
consists of a series of Single Page Forms which are grouped together by the program to appear as if they are in
a card index box. Left Clicking the Tab on a 'card' will bring that Form to the front so that you can then enter data.
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Menus
What are Menus? Menus allow you to instruct the program to perform a series of operations. A menu displays a list of commands from
which you select - similar to a restaurant menu. The Main Menu is shown at the top of the screen.
To use a Menu

1. Point to the required Menu with the Mouse.
2. Left Click - a list of options will appear. Options which are followed by the '>' symbol will open other menus
when clicked.

3. Point to the required Option on the displayed list and Left Click to open a Form - see Tables, Records, Forms
and Fields.
Using Forms

Using Forms you can either:
1. Create new or update existing records by entering data into Fields. Once you have accepted the data entries,
the program will then write this data into the Table and store it (Data Forms) or;
2. Select Records that you wish to read to generate information in the form of reports – generally this does not
require you to update those Records (Print Forms).
The Help file includes comprehensive descriptions of Buttons and Fields to be found on both Print and Data Forms
used for Processing.
Once you have opened the Form you need you then need to find the Record(s) that you want to Read from or Write
to, or create a new Record to add to a Table - see Finding Records.

Menu Structure

Menus follow a tree structure, with the Main Menu representing the whole tree and sub menus and menu items
representing its branches. For reference, a summary of the menu structure is shown below.

Main Menu Name

Options

File (Alt+F)
Instructs the system to Change Date
create
and
maintain Change
Companies and data
Company
Reorganise
Databases
Back
Up
Restore
Exit

Sub Menu

Options

Company
Utilities

Copy Company - Erase Company - Data Cleardown

Stationery
Design

Copy Document Formats - Clear Report<=>Printer Tags (not available in
Accounts (Small Business))
Sub Menu Options

&

Sales
Ledger &
Daybook
Cash
Book

Edit (Alt+E)
Edit data as it is entered

Invoices - Credit Notes - Statements
Remittance Advice

Edit - Undo - Cut - Copy - Paste - Clear - Select All - Find

View (Alt+V)
Parameters - Configure Toolbar - System Information
Instructs the system to use
defined codes and switches
when processing
Status (Alt+t)
VAT Return Date - Period Numbers - At-a-Glance
Shows Company’s liquidity
and transaction periods
Daybooks (Alt+D)
Sales
Instructs the system to create, process and
report transactions
Purchase
Cashbook

Produce Invoices - Produce Credit Notes - Post Invoices - Post Credit
Notes - Daybook Listing
Post Invoices - Post Credit Notes - Daybook Listing
Match SL Transactions - Match PL transactions - Cashbook Listing Cash Sales Listing - Petty Cash Listing - Bank Reconciliation
Sub Menu Options
Receipts

Sales Ledger - Cash Sales - Nominal Ledger - VAT Refund

Payments

Purchase Ledger - Nominal Ledger - Petty Cash - VAT
Payment
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Ledgers (Alt+L)
Sales
Instructs the system to maintain customer,
supplier & nominal account standing data,
adjust transaction records and produce
Management Information

Purchase

Account Maintenance - CSV Import - Account Enquiry - End of Period History Cleardown
Sub Menu Options
Reports

Statements - Ledger cards - Aged Debtors - Nominal
Analysis - List of Accounts - Debtors Letters Output

Sales
Analysis

Product Sales - Customer Analysis - Customer Turnover

Account Maintenance - CSV Import - Account Enquiry - End of Period History Cleardown
Sub Menu Options
Reports

Nominal

Ledger Cards - Aged Creditors - Supplier Analysis Supplier Turnover - List of Accounts - Nominal Analysis

End of Period - Account Maintenance - Account Enquiry - Ledger
Enquiry - Journals
Sub Menu

Options

Standard
Reports

Audit Trail - List of Accounts - Trial Balance - Ledger
Printout - VAT Summary - Input/Output Analysis

Management Profit & Loss - Balance Sheet
Reports
Products (Alt+s)
Create/Amend Products - Create/Amend Services - Create/Amend Descriptions - CSV
Instructs the system to maintain and report Import - Product File List - Price List
product standing data
Help (Alt+H)
Contents - Getting Started - Support - Activation - Upgrade - About
Reference data, licence activation and support
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Control Buttons
What are Control
Buttons?

Control Buttons, like Menus, are used to instruct the program. Left Clicking on a Control Button will open a Form
without prompting you to use a Menu - in effect, they are shortcuts to Menu items.
Control Buttons are displayed below the Main Menu Options on the Toolbar.

Types of Control
Button

There are two types of Control Button:
1.

How do I Display a
Control Button on
the Toolbar?

System Defined - buttons which are always displayed on the left hand side of the Toolbar whenever you
are using the program. These are:
a)

Choose Company Button
- Left Click to select the Company in which you wish to work from
the list displayed - see Change Companies

b)

Accounting date Button
Change Default Transaction Date

c)

Company At-a-Glance Button
- Left Click to display the most recent Trade Debtors and
Creditors, Bank Account and VAT balances, transactions and listings for the working company see Review Bank, Debtors, Creditors and VAT Commitments

- Left Click to change the Default Transaction Date - see

2.

User Defined - Buttons which are shortcuts to frequently used Menu options. You can choose Control
Buttons which are then displayed on the Toolbar, allowing you to modify the workspace to suit your way of
working. You can change which Buttons are displayed at any time.

1.
2.

On the Main Menu Left Click View > Configure Toolbar.
The Configure Toolbar Form appears listing a number of Processes, each of which is accompanied by a
Check Box.
Check the box to choose a process from the list.
When you have completed your selection, Left Click Apply.
Control Button shortcuts on the Toolbar will appear to allow you to go directly to those processes which you
selected. The screenshot illustrates this:

3.
4.
5.

Customer, Supplier and Nominal Enquiry were selected. Control Buttons for these Processes can be seen on the
Toolbar to the right of the At-a-Glance Control Button.
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First, Find the Record....
Why is this
Important?

Data is stored as Records in the system, each Record is identified by its own unique Code - see Tables,
Records, Forms and Fields. The system works by either updating or reporting a particular Record or series of
Records - see Using the System. For processing to be both accurate and complete, users must be able to select
specific Records, either as ranges or individually, to update and/or report.
The first or very early Task within a Process will generally require you to find the required Record in the required
Company that you wish to Process.
The text below explains how this is done.

Find the Company
you need

Search for the
Record you want to
update or . . .

1.
2.
3.

You will see a Drop Down & Search Combo Box at the top left hand side of the Form:
.
1. Left Click the
button to open the Search Form.
2. This will list the records in the Table in which the Form fields are held.
3. In the Search For field enter as much of the name as you can remember. The more text you enter, the more
specific the search. The search is not case-sensitive and will find that text anywhere within an account
name or product description. For example entering “sons” as search text will find “John Smith & Sons”,
“DEBSONS BUILDERS” but not “Allison Smith”.
4. Left Click Find Now button to start the search.
5. The results of the search will then appear in the Search Window.
6. Left Click on the required Record.
7. Left Click on the OK button on the Search Form.
8. The code will appear in the Code Number Field and that Record's Standing Data will appear on the Form.

. . . scroll through to 1.
find the Record you 2.
want to update
3.
4.
Next steps

Select the Company into which you want to enter data - see Change Companies.
Left Click on a menu selection - see Menus.
Left Click on the required option to open the required Form - see Tables, Records, Forms and Fields.

Left Click on the scroll arrows to the right of the Account Number field to move through the list of Codes.
The Code will be displayed in the input box as will the name of the Account or Product alongside the input
box.
The system scrolls through the appropriate files in alphanumeric order.
Left Click OK to accept the Code you require.

Once you have found the correct Record you can start Entering Data.
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...and now Enter Data
Entering Data

After you have found the right Record, you can update it by entering Transactional Data or entering or amending
Standing Data - see Tables, Records, Forms and Fields for a definition of each. Form Fields are labeled so it is
generally clear what the system requires to be input. Generally, Fields in Forms are populated using numbers and
letters typed in from the keyboard or similar input device. Some Fields require Data to be of a particular type and
format, or require you to select options from displayed lists. A description of the types of Field that can be found on
Forms is given below. At any time until you Left Click OK to accept data input to a Form, the program allows you to
make any changes to your input, e.g. for errors made, using standard Windows editing tools. Once a Record is
updated by Left Clicking OK you can change the data you have input only by posting a correcting entry - See Editing
Data Entry.

Navigating a
Form

As you enter data you will need to move between Fields on a Form. To do this you can:
Use the Tab key – you will move from Field to Field in a specific order – the content of each Field will be
•
highlighted. Note that you will not move to the next Page of a Form or the next Line of input until you press
return or Left Click.
•
Left Click on a Field - the content of that Field will be highlighted.
•
Use the Return Key - you will move between Fields in a specific order – the content of each Field will be
highlighted.
The list below shows the types of Field used on Forms.

Field Type

Description

Check Box

Normally, check boxes are shown on the screen as a square box that can contain white space (for false) or a tick
mark or X (for true). Adjacent to the check box is normally shown a caption describing the meaning of the check box.
Inverting the state of a check box is done by Left Clicking the box. For example – you can check a box on a
Customer’s account if you want a statement to be produced for that Customer.

Radio Button

A radio button allows the user to choose one of a predefined set of options. Radio buttons are arranged in groups of
two or more and displayed on screen as, for example, a list of circular holes that can contain white space (for
unselected) or a dot (for selected). Adjacent to each radio button is normally shown a caption describing the choice
that this radio button represents. When the user selects a radio button, any previously selected radio button in the
same group becomes deselected. Left Click the mouse on a Radio Button to select an option - unlike Check Boxes,
only one option can be selected at a time.

Manual Entry
Fields

Generally, input Fields require you to type in text in a specific format – if you type any other format the Field remains
blank. The maximum number of characters that can be entered varies with each Field and is controlled by the system
– once the limit is reached, the Field will not accept any further input. The Field Name shown on the Form will be a
good indication of the type of data to be entered, this will be one of three types:
•
Alpha – accept letters only
•
Alphanumeric – accepts combinations of letters and numbers
•
Numeric – accepts numbers only. Usually displayed as zeroes to required number of decimal places
To enter Data:
1. Left Click in a Field or Press Tab to move to a Field
2. Type in Text
3. Press Return to accept and move to the Next Field
4. Note that some Fields will default to Upper Case when the input is accepted

Date Fields

To enter a Transaction Date either:
1. Formatted as DD/MM/YY. Type over the parts of the date you wish to change. The system will skip over the “/”
characters itself. If the date you enter is invalid, the cursor will return to the start of the date and await a valid
entry, or;
2. Right Click in the Date Field - a menu will appear - Left Click on an Option. The options are explained below:
a) Calendar - Left Click to open the Calendar Form - see Calendar Form - and select the Transaction Date
b) Today - Left Click to enter Default Transaction Date, populate the Field and close the Menu
c) Day+ - Left Click to enter Default Transaction Date plus one day, populate the Field and close the Menu
d) Day- - Left Click to enter Default Transaction Date less one day, populate the Field and close the Menu
e) Week+ - Left Click to enter Default Transaction Date plus 7 days, populate the Field and close the Menu
f)
Week- - Left Click to enter Default Transaction Date less 7 days, populate the Field and close the Menu
g) End of Last month - Left Click to enter the last day of the month before the Default Transaction Date,
populate the Field an close the Menu
h) Beginning of This Month - Left Click to enter the first day of the month in which the Default Transaction
Date falls, populate the Field and close the Menu

Drop-Down Box

Also called a drop-down menu, this is a menu of commands or options that appears when you Left Click on an arrow
icon. To use a Drop-Down Box:
1. Left Click on the Down Arrow on the right hand side of the Field.
2. A list of items will be displayed.
3. Scroll through the list.
4. Left Click on an item.
5. The item will now appear in the Field.
6. Press Return to accept and move to the Next Field.

Calculated
Display

These Fields are the result of calculations or display data on Forms which can then be printed. You cannot enter data
into these Fields.
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Editing Data Entry
When do I use this?

You can use standard Windows tools to edit data being entered on a Form - see ...and now Enter Data.
Remember that once you have updated the Record this data cannot be changed using the Edit menu.
After this you can make adjustments only by using Journal Entries - see Make Nominal Ledger
Adjustments.

Using Editing Tools

1.
2.
3.

Left Click a Field - this will highlight the Text - it will appear as white on a blue background
Either: Left Click Menus > Edit
a) Left Click on Option to Edit Text, or;
Right Click to display the Edit menu, then
a) Left Click on the required Option to Edit Text

Options available are listed below:
Edit Option

Keyboard Shortcut

Undo

Control+ Z - clears the latest entry

Cut

Control+ X

Copy

Control+ C - For example use this to copy the results of a calculation from the Calculator screen to a
Field on a Form.

Paste

Control+ V - Use with Copy and Cut above

Clear

Delete

Select all

Control+ A
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Printing Reports
How do I do this?

The same basic steps are used to run reports and print documents within the system.
To print a report or document:
1. Select the required Company - see Change Companies.
2. Either:
a) Produce a Document - for an example see Produce Sales Invoices , or;
b) Select a Record or a range of Records to be reported - for an example see Print Customer
Statements.
3. Left Click OK to accept the data.
4. Choose the required output medium.

Choose your Output

1.
2.

3.

Left Clicking to accept input will open the Select Output Form.
Pick how the output should be presented - you can:
a) Print the report to a designated printer, or;
b) Display the report on the screen and then either view or print the display, or;
c) Save the report as a file by selecting a format form a drop-down list – you could then
incorporate this file into a report or email it to your colleagues, Customers or Suppliers. The
file you create will be stored in the same folder as the rest of the current Company's data
unless you specify a different location.
If using a printer, set this up as you require - see Print Setup Form.
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Period-End Processing
When and How
Often?

Monthly - Accounts (Small Business) Ledgers accumulate transactions and produce reports in 12 discrete
Transaction Periods within a financial year - see Using the System.
Each of the Sales, Purchase and Nominal ledgers has its own routine that must be run separately.
The Period end routines:
Close the current period and so prevent any further transactions being created or adjusted in that Transaction
•
Period in the ledger;
•
Advance the Ledger period by 1 into the next period;
•
Clear down all matched transactions into history.
Subject to the Period Rule (see Using the System), Accounts (Small Business) will allow ledgers to close at varying
times. Retail businesses, for example, usually close Sales Ledgers on Day 1 of the Period End, whilst the
Purchase and Nominal Ledgers may remain open for several days more. You can check to see which Transaction
Period is open for each Ledger at any time - see Check Ledger Periods.
See also Suggested Month End Procedures. This is a useful sequential checklist of Month End tasks.

Preparation

•
•
•
•
•

Ensure all the current Transaction Period's data has been processed.
Ensure all other users are off the System until Period End is completed.
Ensure Sales & Purchase Daybooks have been printed - see Print Sales or Purchase Daybook Listings.
Ensure VAT reports have been printed - see Print a VAT Summary.
Process Sales and Purchase Ledger Period Ends before processing Nominal Ledger Period End.

Processing

1.
2.
3.

Left Click Menus > Ledgers > Sales > End of Period to open Form - see Sales Ledger End of Period Form.
Left Click OK to process Period End.
Warning Message will appear if Daybook has not been printed, Left Click Yes to continue, No to stop process
- see Print Sales or Purchase Daybook Listings.
Left Click Menus > Ledgers > Purchases > End of Period to open Form - see Purchase Ledger End of Period
Form.
Left Click OK to process Period End.
Warning Message will appear if Daybook has not been printed, Left Click Yes to continue, No to stop process
- see Print Sales or Purchase Daybook Listings.
Left Click Menus > Ledgers > Nominal > End of Period to open Form - see Nominal Ledger End of Period
Form.
Warning Message appears if Cashbook listing has not been printed - see List Cashbook Transactions.
Left Click OK to process Period End.

4.
5.
6.
7.
8.
9.

After processing Period 12 the Year End Routine will run. This will:
Clear down all transactions in the Nominal Ledger;
•
•
Reset all Profit & Loss type account balances to zero;
•
Transfer the net profit or loss for the year to the P&L Revenue Reserves Control Account as defined in the
VAT and Nominal Codes Page of the Parameters Form.
Reporting

Tell other users when processing is complete and distribute reports as required.
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Suggested Month-End Procedures
Overview

You can use the information here as part of the system Control Framework - see Using the System. It is a
sequential checklist of tasks required to be completed in order to close one Transaction Period and open the next.

Post Sales and
Purchase Daybook
Transactions

•
•
•

Post all monthly invoices, receipts & payments transactions
Match Sales and Purchase Ledger entries as required.
Reconcile Supplier Statements to Ledger Accounts and make any adjustments required.

Run Sales Reports

•
•
•
•

Sales Daybook Listing
Sales Activity Reports (if required)
Aged Debtors (detailed preferred)
Customer Statements

Run Purchase
Reports

•
•
•
•

Purchase Daybook Listing
Supplier Turnover (if required)
Aged Creditors (detailed preferred)
Ledger Cards (if required)

Run Sales and
Purchase Ledger
Period Ends

See Period End Processing

Post Nominal
Transactions

•

•

•

Post all receipts & payments not related to the Sales or Purchase Ledgers through the Cashbook. Remember
that VAT payments and refunds have a separate option in the Cashbook. Complete posting any cash sales
and petty cash payments for the month. This could be standing orders, direct debits, bank charges and
interest, rent payments etc.
Journal all other transactions through the Nominal Ledger journal menu. These could include such things as
standing orders, direct debits, rates, and bank charges etc. Examples are accruals, prepayments and
depreciation.
Enter Payroll transactions - see Post Payroll.

Reconcile Accounts Reconcile Control Account Balances to Ledger Accounts and/or source data as required.
Print Nominal and
Cashbook Reports

•
•
•
•
•
•
•
•
•

Cashbook listing
Petty cash listing
Cash sales listing
Audit trail for the period
Trial balance (year to date)
VAT Summary
Input/Output Analysis Form
VAT Return Form (if required)
Ledger printout (optional)

Back Up your Data

•

Remember to store a copy of a backup in a safe place, preferably away from your workplace. See Back Up
Company Data.
We recommend that you create a copy Company before running Period End and Year End routines.
See Copy Company Data, Create New Companies
This will create a series of easily accessible archives of Company at key stages for future reference.

•
•
•
Run Nominal
Ledger Period End

See Period End Processing

Produce
Management
Reports

See Produce Management Reports
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